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Purpose:  This procedure details basic features of navigating within Oracle Applications. It includes 
searching for accounting periods, account strings, budget numbers, suppliers, projects, and journal 
entries, including search features in the web based Oracle windows.  Miscellaneous features include 
exporting data, popular toolbar icons, folder tools, and the zoom feature.  

 

For Questions Contact: Finance Customer Care at financecustomercare@ohio.edu or 740.597.6446. 
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WELCOME TO ORACLE E-BUSINESS SUITE, VERSION 12.1.3 

Welcome to the Oracle E-Business (eBiz), version 12.1.3. Use this navigation document to aid you in 
accessing information. Refer to the Table of Contents for quick access to specific information. 

 

BROWSERS FOR ORACLE E-BUSINESS SUITE, VERSION 12.1.3 

 

Operating System Supported Browsers 

*Windows 8 IE 10 

*Windows 7 IE 8, IE 9, and IE 10 

*Windows Vista IE 7, IE 8, and IE 9 

*Windows XP IE 6, IE 7, and IE 8 

*Window systems also are certified for Firefox browsers: 
Firefox ESR 24.3.6 or higher OR Firefox ESR XX.x 

MAC OS X v10.7.5 or higher Safari 6.0x (x=2 or higher) 

MAC OS X v10.8.2 or higher Safari 6.0x (x=2 or higher) 

MAC OS X v10.9.1 or higher Safari 7.0x (x=1 or higher) 

 

ATTN: PLEASE VERIFY THAT YOU ARE USING A CERTIFIED BROWSER PRIOR TO LOGIN TO EBIZ.  

GOOGLE CHROME IS NOT A CERTIFIED BROWSER. 
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LOGIN TO EBIZ 

Navigate to Oracle Enterprise Business Systems window using the following navigation path; 

1. Enter the Enterprise Business Systems URL into your browser window address bar; 
http://www.ohio.edu/ebiz/ebiz.html.  

2. Click Oracle e-Business Suite link. 

 

3. Enter OHIO ID and Password. Click Login button. 

 

4. Once you are logged into Oracle e-Business and are on the Oracle Applications Home Page 
you may access any of your responsibilities. 

 

NOTE: A responsibility is a predefined set of data, menus, and forms that define your particular 
level of access to Oracle application menus. The OUFMS: View Only responsibility allows end 
users the capability to search for and view data in the system.  

http://www.ohio.edu/ebiz/ebiz.html
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5. Click the appropriate link to open the desired module. A popup window displays. 

 

6. Oracle eBiz requires the use of Java Runtime Environment (JRE). If JRE is not already loaded 
on your computer, you will be prompted to load the software. If you have questions or 
concerns, please contact the OIT Service Desk (740.593.1222). 
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EXIT EBIZ 

Depending on your current screen, you can have several processes to exit the system. 
If you are on one of the Oracle HTML windows and you see the Home and Logout links at the top of 
the window, follow these directions.  

 

1. To return Home (Main Menu), click the Home link at top of window.  
2. To logout of Oracle E-Business Suite, click the Logout link at top of window. Go to step #4. 

 
If you have the Close Window link at the top of the window, follow these directions. 

 
3. To logout of Oracle web based forms, click the Close Window link at top of window. 
4. The Oracle Applications windows remain open. 
5. To exit the system, click the File menu option and click the Exit Oracle Applications option. 
6. A Caution window displays to confirm your selection. Click OK to exit the system.  

 
 

SWITCH RESPONSIBILITY 

Each user has at least one responsibility in Oracle. If you are a user that has more than one 
responsibility you can switch responsibilities (“change hats”) within Oracle. 

1. Click File>Switch Responsibility from the menu bar or click the Switch Responsibility  
icon. The Responsibilities window displays. 

2. Click the appropriate Responsibility. 
3. Click OK. The Navigator window for the new responsibility displays. 
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THE NAVIGATOR WINDOW 

 

Part Function 
 Menu bar 
 Tool bar 
 Window title bar:  includes the window title and either the 

user responsibility (on the Navigator window) or the 
document number (on most other windows). 

 Current responsibility 
 Top Ten List used to provide direct access to frequently used 

options 
 Expand and collapse menu 
 Displays the available menu options for the current 

responsibility 
 Status Bar-When conducting searches it will display the 

number of records retrieved. 
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ORACLE TOOLBAR ICONS 

The toolbar is a collection of icons (buttons), where each button performs a specific action. Each 
toolbar button replicates a commonly used menu bar item. Depending on the context of the current 
field or window, a toolbar button can be enabled (in color) or disabled (in grey). You can display help 
or a tool tip for an enabled toolbar button by hovering your mouse over the button. 

NOTE: To return to the Navigator (main menu) anytime click on the Show Navigator icon . 

 

Oracle Toolbar Menu Icons 

Menu Item ICON Description 

New  
 

Creates a new record in the active form 

Find  
 

Displays the Find window to retrieve records 

Show 
Navigator  

 
Displays the Navigator window, which brings you back to the main menu 

Save  
 

Saves any pending changes in the active form 

Next Step  
 

Updates the Process workflow in the Navigator by advancing you to the 
next step in the process and saves pending changes in the active form. 

Switch 
Responsibility  

 
Allows user the ability to change responsibility (“change hats”) 

Print  
 

Prints the current screen 

Close Form  
 

Closes all windows of the current form 

Cut  
 

Cut the current selection to the clipboard  

Copy  
 

Copies current selection to the clipboard 

Paste  
 

Pastes from the clipboard into the current field 

Clear Record  
 

Erases the current record from the form on data entry screens 

Delete  
 

Deletes the current record from the database on data entry screens 

Edit Field…  
 

Displays the Editor window for the current field; this is useful if the data 
for the field exceeds the displayed field size. 

Zoom  
 

Invokes custom defined Zoom (drilldown behavior). 

Translations…  Not applicable for Ohio University.  

Attachments…  
 

Invokes the Attachments window.  If one or more attachments already 
exist, the icon changes to a paper clip on a piece of paper. 

Folder Tools  
 

Displays the folder tool palette for working with screens with 
customizable folders 

Window Help  
 

Displays Oracle standard help for the current window (not OU specific 
text) 



Oracle Navigation    Document ID: FMSNAV0010 

  Effective Date: 08/07/2014 

 

Page 10   

Finance   

EXPAND AND COLLAPSE BUTTONS 

On the Navigation screen, some menu options are shown with a plus sign (+) to the left. Items that 
begin with a (+) plus can be expanded to further sub-levels until you find the specific option by 
highlighting the line and selecting one of the following buttons: 
 
 

Button Function 

 
Expand button expands the highlighted menu item.   
 

Note:  Menu items with a “+” to the left of them have submenus and can be expanded. 

 
Collapse button collapses the highlighted expanded menu. 
 

Note: Menus with a “-” to the left of them have submenus and may be collapsed. 

 
Expand Branch button expands all branches of the highlighted menu. 

 
Expand All button expands all menus and submenus. 

 
Collapse All button collapses all expanded menus and submenus. 

  

You may also click the plus (+) or minus (-) symbol to expand or collapse a menu item. 

 

MENU BARS 

The main menu bar is located at the top of the window. When you click on a menu bar item, a drop 
down list of options will allow you to perform various function throughout the application. When 
you navigate to a window, specific options appearing in gray are unavailable in that particular 
window. To access the options in the menu using the keyboard, simultaneously press the Alt key 
and the underscored letter in the menu item you want to access. For example, pressing the Alt and 
F keys simultaneously would open the File menu. You may also access the File menu by clicking File. 

MENU FUNCTIONS ARE BASED ON THE SCREEN FUNCTIONALITY. INQUIRY 
SCREENS WILL NOT USE ANY OPTIONS THAT INVOLVE CREATING, EDITING, OR 

SAVING TRANSACTIONS. 
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File Menu 

Menu Function 

 

 

File Menu 

 

New Creates a new record in the active form. 

Open Opens the detail window for the 
current selection. 

Save Saves any pending changes in the active 
form. 

Save and Proceed Saves any pending changes in the active 
form and advances to the next record. 

Next Step Updates the Process workflow in the 
Navigator by advancing to the next step 
in the process. 

Export Exports information in your current 
form to a browser window. 

Place on 
Navigator 

Creates an icon in the Documents tab of 
the Navigator. 

Log on as a 
Different User… 

Allows you to log on to Oracle 
Applications again as a different user. 

Switch 
Responsibility… 

Allows you to change your current 
responsibility 

Print… Prints your current window. 

Close Form Closes all windows of the current form. 

Exit Oracle 
Applications 

Quits Oracle Applications. 
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Edit Menu 

Menu Function 

 

 
Edit Menu 
 

Undo Typing Undoes any typing done in a field 
before the field is exited and returns 
the field to the most recent value. 

Cut Cut the current selection to the 
clipboard. 

Copy Copy the current selection to the 
clipboard. 

Paste Paste the contents of the clipboard 
into the current field. 

Duplicate 
 

 

 Record Above – Copies all values 
from the prior record to the 
current record. 

 Field Above – Copies the value of 
the current field from the prior 
row. 

Clear 
 

 

 Record – Erases the current 
record from the window. 

 Field – Clears the data from the 
current field. 

 Block – Erases all records from the 
current block. 

 Form – Erases any pending 
changes from the current form. 

Delete Deletes the current record from the 
database. 

Select All Selects all records (for blocks with 
multi-select). 

Deselect All Deselects all selected records except 
for the current record (for blocks 
with multi-select). 

Edit Field… Displays the Editor window for the 
current field. 

Preferences 
 

 

 Change Password – Displays the 
Change Password dialog box. 

 Profiles – Displays the Profiles 
window. 
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View Menu 

Menu Function 

 

 

View Menu 
 

Show Navigator Displays the Navigator window. 

Zoom Invokes custom defined zooms. 

Find… Displays the Find window to retrieve 
records. 

Find All Retrieves all records. 

Query By Example 
 

 

This is used to find records : 

 Enter – Invokes ‘Enter Query’ 
mode to enter search criteria for a 
query-by-example. 

 Run – Executes the query-by-
example. 

 Cancel – Cancels the query-by-
example by exiting from ‘Enter 
Query’ mode. 

 Show Last Criteria – Recovers the 
search criteria used in the 
previous query-by-example. 

 Count Matching Records – Counts 
the number of records that would 
be retrieved if you ran the current 
query-by-example. 

Record 
 

 

 First – Moves the cursor to the 
first record. 

 Last – Moves the cursor to the last 
record. 

Translations… Displays the Translations window. 

Attachments… Displays the Attachments window. 

Summary/Detail Switch between the summary and 
detail views of a combination block. 

Requests Displays the Requests window. 
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Folder Menu 

The Folder menu and options are explained in the next section (Folder Tools). 
 

 

 

Tools, Inquire, Report Menus 

The Tools, Inquire, and Report menu options vary by the currently selected window. Instructions are 
included in each document if these menu options are relevant to an OUFMS: View Only user. 

 

Window Menu 

Menu Function 

 

Window Menu 
 

Cascade Displays any open windows in a “cascaded” or stair-
stepped fashion. 

Tile Horizontally Displays any open windows in a horizontally “tiled” 
(non-overlapping) fashion. 

Tile Vertically Displays any open windows in a vertically “tiled” (non-
overlapping) fashion. 

 1 (Title of Open 
Window) 

Displays a list of open window titles in the order in 
which they are stacked. 
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Help Menu 

Menu Function 

 
 

Help Menu 
 

Window Help Displays Help for the current window. 

Oracle Applications 
Library 

Displays a window that lists all available Oracle 
Applications Help text. 

Keyboard Help… Displays keyboard shortcuts. 

Diagnostics There are multiple Diagnostics menus used for 
coding and debugging. 

Record History Displays information about who created and 
last updated the current record. 

About Oracle 
Applications… 

Displays information about the current Oracle 
instance, module, and form. 

 

 

Keyboard shortcuts 

Almost everything that can be accessed through the menu bar can be accessed using keyboard 
shortcuts. 

1. Click the Help menu item, then click on Keyboard Help, or 
2. Press CTRL+K to be reminded of the shortcut keys. 
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FOLDER TOOLS 

Folder Menu 

For some forms, you can personalize the presentation of data within a form by using a folder 
definition.  With a folder definition you can modify the width, sequence, and prompts of the fields 
you want to display.  Additional features of a folder definition are: 

 

 Displaying only those fields you are interested in viewing. 

 Displaying a subset of records based on your specific criteria. 

 Automatically querying for a subset of records each time you open a specific folder. 

 Keeping your folder customizations private or making them public for others to use. 

 Making your customizations the default layout for a folder. 

IN ORDER TO GET TO ENABLE A FOLDER MENU FOR A WINDOW YOU MUST 
SEARCH AND RETRIEVE DATA IN ORDER TO OPEN THE WINDOW WHERE THE 

CUSTOMIZABLE FOLDER IS LOCATED. 

 

How Do You Know if a Form Folder Can Be Customized? 

Open a form, i.e. Projects>Project Status Inquiry. An Open Folder button  appears in the upper-
left corner of the window. Also, an enabled Folder Tools icon appears on the toolbar when your 
cursor is in a folder block.  
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Folder Tools Icon Opens the Folder Tools Palette 

When you navigate to a folder block, the Folder Tools icon illuminates on the toolbar. Choose this 
icon to display the Folder Tools palette for your use. The Folder Tools palette includes buttons that 
replicate the actions of some commonly used Folder menu options. The Folder Tools palette buttons 
are explained top row first, left to right, then second row, etc. 

 

 

Folder Tools Palette 

Button Action 

Open Folder Open an existing folder.  

Save Folder Save changes to the current folder.  

Create New 
Folder 

Create a new folder.  

Delete Folder Delete an existing folder.  

Widen Field Increase the width of a field.  

Shrink Field Decrease the width of a field.  

Show Field Show a field that is currently hidden.  

Hide Field Hide a currently field.  

Move Left Move the current field one column width to the left. 

Move Right Move the current field one column width to the right. 

Move Up Move the current field up one column. 

Move Down Move the current field down one column. 
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Folder Tools Menu Options 

You can customize the presentation of data in a folder using the Folder menu.  Many of these items 
are also available from the Folder Tools icon on the toolbar. 
 

  

 

Folder Definitions 

Once you customize a folder's layout and query criteria, you should save your customizations to a 
folder definition. You can create and save new folder definitions or open and delete existing folder 
definitions. When you open a new folder definition, the layout for the new folder definition replaces 
the layout for the current folder definition.  

If you want to use a folder view for various data queries, do not save the query with the folder view. 
(See following sections) 

Menu Item  Action 

New Creates a new folder definition  

Open Opens a saved folder definition.  

Save Saves changes to the current folder definition.  

Save As  Saves current folder definition to a new name. 

Delete Deletes an existing folder definition.  

Show Field  Displays a field that is currently hidden.  

Hide Field Hides the current field.  

Move Right  Moves the current field to the right.  

Move Left  Moves the current field to the left. 

Move Up  Moves the current field up (not available in all folders).  

Move Down  Moves the current field down (not available in all folders). 

Widen Field  Increases the width of the current field.  

Shrink Field  Decreases the width of the current field  

Change Prompt  Changes the heading prompt for the current field.  

Autosize All  
Adjusts all field widths proportionally to fill window. 
This cannot be undone without resizing each window.  

Sort Data  
Toggles the display of the Order By Buttons so you can 
specify the sort order for the first three field columns.  

View Query  Displays query criteria for the current folder definition.  

Reset Query  Erases the current query criteria.  

Folder Tools  Displays the folder tool Palette 
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Create a New Folder without a Query 

To create a new folder, or update an existing one, use the options from the folder menu. You can 
save a new folder as private or public if you want to share your customized view. 

1. Perform a query on the particular form so there is data in the window in which you would 
like to create a folder. 

2. Customize the window to your own preferences; hiding columns you don’t need, show the 
ones you do, change column titles, and size. Use the Folder Tools icon or the Folder menu. 
o What fields are displayed 
o Width of fields 
o Order of columns displayed 

3. Click on the Toolbar Menu Folder>Save As. 
4. Enter a folder name in the Folder field. 
5. Select the Autoquery option. 

o ‘Always’ will save your existing query-the data you currently see in the window. If you 
do save the query, change the folder name to reflect that it is saved. Don’t make the 
saved folder your default folder. 

o ‘Never’ allows you to use the folder as a template for viewing results of future queries. 
o ‘Ask each time’ will ask you which function you would like to perform each time.  

6. Select the Open as Default option if you want this folder to be your default each time you 
access the particular form.  

7. Select the Public option if you need to share the folder definition with other users. They can 
use it as their default folder, but only the creator of the folder can modify it. 

8. Verify the Include Query option is unchecked. 
9. Click OK button. Caution popup window displays. 

 

10. Click OK. 

 



Oracle Navigation    Document ID: FMSNAV0010 

  Effective Date: 08/07/2014 

 

Page 20   

Finance   

Create a New Folder as a Query 

NOTE: When you save a folder definition, the search criteria/query is saved to the folder 

definition. When you perform another query on that same folder definition, you actually query 

on the subset of records that could possibly be shown in that block. If you want to perform a 

new query on all Oracle data, reset the query for the folder definition before performing 

another query. 

1. Run the query to obtain the desired results. At least one record must result from the query 
for the folder to record the query. 

2. Customize the window to your own preferences; hiding columns you don’t need, show the 
ones you do, change column titles, and size. Use the Folder Tools icon or the Folder menu. 
o What fields are displayed 
o Width of fields 
o Order of columns displayed 

3. Click on the Toolbar Menu Folder>Save As. 
4. Enter a folder name in the Folder field. 
5. Click Always radio button for the Autoquery frequency. The query will run every time you 

open the folder.  
6. It is recommended that you leave the Open as Default and the Public options unchecked. 
7. Click the Include Query checkbox. 

 

8. Click OK. Caution popup window displays. Click OK. 

 

Changing the Query Criteria for a Folder Definition 

1. Choose Folder > Reset Query to clear the query criteria from the current folder 
definition. The folder retains the current name and field layout. A Caution popup 
window displays. 

ATTN: THE FOLDER RETAINS THE CURRENT NAME AND FIELD LAYOUT. 

2. Click OK button. 
3. Click Find icon. 
4. Enter your new search criteria. Search results display. 
5. Choose Folder > Save to save the new query to your current folder definition. 
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Open Predefined Folders Created by Finance 

Within the various modules, Finance staff may have created a recommended folder view of menu 
options. Follow these directions to open, verify if there are predefined folders, and if applicable, 
save the folders. 

1. Click on the Toolbar Menu Folder>Open. The Open Folder window displays the available 
folder views.  
 
You can also click on the Open Folder icon located in the upper-left corner of the window. 

 
2. Click on New OUFMS: View Only XXXXXXXXX Screen created by STAFF OHIO ID (OWNER). 

Each folder definition name (XXXXXXXX) will be different based on name assigned the folder 
by the folder creator. The Grants & Contracts staff defined the XXXXXXX to be equivalent to 
the window name. 

 
3. Click OK button. 

4. Complete these same steps to select a folder view.  

 

ATTN: GRANTS AND CONTRACTS ACCOUNTING STAFF HAS CREATED RECOMMENDED FOLDERS FOR PROJECT STATUS, 
TASK STATUS, RESOURCE STATUS, EXPENDITURE ITEM DETAILS, AND COMMITMENT DETAILS WINDOWS.  
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Delete a Folder Definition 

To delete an existing folder definition that you created: 
1. Click on the Toolbar menu Folder > Delete.  
2. Click a folder definition in the list. You will only see folder definitions that you created.  
3. Click OK to delete the definition. 

 

NOTE: If you made your folder definition “public” and other users are referencing that folder 

definition as their “open as default” folder, that reference is deleted as well. 

DESCRIPTIVE FLEXFIELDS (DFF) 

Oracle uses Descriptive Flexfields (DFF) to customize the application and capture additional 
information that is important and unique to the business needs of Ohio University. The DFF is 
basically an informational box. DFF’s may be defined by the university in any of the modules. The 

DFF is represented by the DFF icon . If you are viewing data in a table format, the DFF icon will 
appear at the top of the column. The DFF will open a window with a window name specific to that 
particular module. For example, in the Purchasing module, the DFF opens a window titled PO 
Headers window. 
 

SEARCH MODES 

In Oracle forms, you may use a query to search for specific information. There are two ways to 
create queries: Find Screen and Query Mode. 
 

Find Mode 

Many of the menu options in Oracle provide a “find” screen to locate records. If not, you can use 
Query Mode to select records. 

1. Access the Oracle window from which you want to initiate the search. 

2. If the Find window does not automatically appear, click the Find Icon  to open the 
particular Find window. 

3. Enter search criteria in the appropriate fields. Use the wildcard symbol (%) before and after 
the search phrase or especially a partial search phrase.  

4. Click Find button to initiate search. Results should display in current window. 
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Query Mode 

1. Access the Oracle window from which you want to initiate the search. 
2. Press F11 key. This action activates the Query Mode. The searchable fields will turn blue 

indicating that the window/fields are in Query Mode. 
3. Enter search criteria in the blue fields. Use the wildcard symbol (%) before and after the 

search phrase or especially a partial search phrase.  
4. Press Ctrl key + F11 key to initiate search. Results should display in current window. 
5. Press F4 key to cancel query. 

 

The Percent % Symbol is a Wildcard 

The “%” symbol is a wildcard when performing searches or narrowing lists of values. A wildcard 
refers to a character that can be substituted for any number of characters in a string.  

Example: If you enter 89% in the PO Number field, the results will display all purchase orders with an 
“89” followed by any number (8900, 8901, 8920, 8921, etc.). 

 

LIST OF VALUES 

The List of Values (LOV) provides you with a powerful, easy-to-use data entry method that increases 
your accuracy and productivity. Using the LOV makes data entry an easy task for novice users, and 
experienced users can enter correct data with a minimum number of keystrokes. If you know the 
value, you can key the initial characters of the value and press the Tab key, either the value will be 
displayed or a list of values will be displayed.  

1. Click the LOV icon  in the field. List of Values displays.  

 
2. When you click the LOV icon, Oracle will display a window where you can enter list 

reduction criteria, if the field has a long list of values. 
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3. Follow the options below to limit the size of a LOV. 
o If you know the full name of the item you are searching for, in the Find field, enter the 

full name, and click Find. 
o If you know part of the item you are searching for: 

 Enter %. 
 In the Find field, enter any number of characters followed by a %. 
 Click the Find button. For example, if you enter %budget%, you will retrieve any 

data with the word or part of the word containing “budget.”  

AVOID USING ONLY THE % SYMBOL ONLY. THIS MAY CAUSE EXCESSIVE NETWORK 
TRAFFIC AND REDUCED PERFORMANCE FOR ALL USERS. 

 

ACCOUNTING PERIODS 

The Fiscal Year 

Ohio’s fiscal year runs from July 1st through June 30th. Fiscal year is referenced by the year when the 
fiscal year ends (Example: FY 2014 is July 1, 2013 through June 30, 2014). 

 

Month End 

The books for each month are closed on the fourth business day after the month ends. This allows 
finance staff time to process transactions before the closing process. At year end, you will receive 
reports for the (June) 1st Close and the (June) 2nd Close. This allows finance staff time to process all 
FY transactions and complete the Fiscal Year End Close. After the closing process, you will receive an 
email including the link to your online reports. 

 

1. Click in the From field. The Accounting Periods From/To fields are defaulted with the current 
month Accounting Period. 

 

2. Enter the Month, Calendar Year and Fiscal year (JUN 2014-14)  

o Enter JUN and hit tab or 

o Enter JUN 2014 and hit tab, or 

Click the List of Values (LOV)  button. The From Periods window is displayed. 
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NOTE: The To field will populate with the same data entered in the From field. This period From/To 
combination would pull up one month of activity. The To field can be changed to select a range of 
accounting periods.  

3. Enter a partial description plus the wild card (%).  
4. Click Find button. The results are displayed. 

  

 

5. Click the selected Period and click OK. 
6. Click in the To field. (key value or use LOV). 
7. Click the selected Period and click OK.  

 

ACCOUNT STRINGS 

Throughout Oracle eBiz, screens provide opportunities to query a single account or a range of 
accounts. Each segment field has a specific number of digits. The project field is the only 
alphanumeric segment.  

 FUND TYPE = XXX (3 digits).  To query an account range, enter (000-999). 

 FUND= XXXX (4 digits). To query an account range, enter (0000-9999). 

 ORGANIZATION=XXXXX (5 digits). To query an account range, enter (00000-99999). 

 NATURAL ACCOUNT=XXXXXX (6 digits). To query an account range, enter (000000-
999999). 

 PROJECT=UNXXXXXXX (alphanumeric= 2 letters and 7 digits, except null project = all 
zeroes). To query the entire range of projects, enter nine 0’s and nine Z’s (000000000-
zzzzzzzzz). 
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Account Code Structure 

ATTN: THE ACCOUNT CODE STRUCTURE FOR A DEPARTMENT/PROGRAM/PROJECT IS: 

Fund Type Fund Organization Natural 
Account 

Project Task 

XXX XXXX XXXXX XXXXXX XXXXXXXXX XX.XX.XX 

 

Fund Type 

The Fund Type segment is three digits and is designated as the balancing segment within the 
account code structure. It is used to distinguish between the University and Foundation within FMS. 
Its main purpose within each of these entities is to group types of funds together. 

Fund Type Fund Organization Natural 
Account 

Project Task 

XXX XXXX XXXXX XXXXXX XXXXXXXXX XX.XX.XX 

 

Fund 

The Fund segment is four digits and differentiates between the pools of money that are used to 
record revenue and expenditures. 

Fund Type Fund Organization Natural 
Account 

Project Task 

XXX XXXX XXXXX XXXXXX XXXXXXXXX XX.XX.XX 
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Organization 

The Organization segment is five digits and represents the core departments within the University. 

Fund Type Fund Organization Natural 
Account 

Project Task 

XXX XXXX XXXXX XXXXXX XXXXXXXXX XX.XX.XX 

 

Natural Account 

The Natural Account segment is six digits and is used to properly classify all accounting transactions. 
It is used to indicate whether an accounting line is recorded as an expense, revenue, asset, or 
liability. 

Fund Type Fund Organization Natural 
Account 

Project Task 

XXX XXXX XXXXX XXXXXX XXXXXXXXX XX.XX.XX 

 

Project 

The Project segment is nine digits and is used to capture costs of programs/projects/activities of the 
core departments (Organization) within the University. It is also the link to the Project Accounting 
module for those accounts that utilize it. 

Fund Type Fund Organization Natural 
Account 

Project Task 

XXX XXXX XXXXX XXXXXX XXXXXXXXX XX.XX.XX 

 

Task 

The Task segment is used in the Project Accounting (PA) module only to track the accounting of a 
transaction to a finer level of detail. This segment is used in the PA module only, which is currently 
only utilized for grant, contract, capital improvement, and plant fund accounts. 

Fund Type Fund Organization Natural 
Account 

Project Task 

XXX XXXX XXXXX XXXXXX XXXXXXXXX XX.XX.XX 
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Cost Center 

 

ATTN: A COST CENTER IN THE GENERAL LEDGER IS:  

FUND TYPE, FUND, ORGANIZATION, NATURAL ACCOUNT, AND PROJECT 

 

Example: 010-0000-20010-XXXXXX-UN2006000 

 

A COST CENTER IN PROJECT ACCOUNTING IS:  

FUND TYPE, FUND, ORGANIZATION, NATURAL ACCOUNT, PROJECT, AND TASK 

Example: 010-0000-20010-XXXXXX-GA017434H-14.05 

 

Low and High Values for Each Segment 

There is a defined list of account code segment values. Since this list may change over time, please 
refer to the online Segment Values list on the Finance Customer Care Center web site. 

1. Enter the Customer Care Center URL into your browser window address bar; 
http://www.ohio.edu/finance/customercare/index.cfm .  

2. Click on Segment Values link.  
3. Click Open. 
4. Click on the appropriate tab at the bottom of the excel sheet (Fund Type, Fund, Organization, 

Natural Account, Project). View segment values. 
 

Entering Account Strings 

1. Click anywhere on the first row of the Accounts section. A blue highlight appears in the row. 

 

2. The Find Accounts window is displayed. 

http://www.ohio.edu/finance/customercare/index.cfm
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3. Enter data manually or use the List of Values (LOV). See next two sections.  

 

Enter Data Manually  

1. Enter the appropriate value in the each Low/High segment field (i.e., Accounting Flexfields).  

2. Use the tab key to move between Account code segments.  

NOTE: System automatically moves you to the High field in each segment and transfers the same 
entry. Leave this default in all the High fields if you are querying one account code combination 

3. Enter value in Fund Type / Low field (i.e., 010). 

4. If querying a range of Fund Types, enter value in Fund Type /High field (i.e., 010) then tab.  

5. Enter value in the Fund / Low field (i.e., 0000). 

6. If querying a range of Fund accounts, enter value in Fund /High field (i.e., 0000), then tab. 

7. Enter value in the Organization / Low field (i.e., 20000). 

8. If querying a range of Organizations, enter value in the Organization /High field (i.e., 29999), 
then tab. 

9. Enter value in Natural Account / Low field (i.e., 300000).  

10. If querying a range of Natural Accounts, enter value in Natural Account /High field  

(i.e., 958000), then tab. 

11. Enter value in the Project / Low field (Alphanumeric Format, i.e., UN2006000). The first two 
characters must be capitalized. The only exception is the null project which is nine zeroes. If 
querying a range of all Projects see section below. 

12. If querying a range of Projects, enter the value in Projects/High field (Alphanumeric Format: 
XX#######).The first two characters must be capitalized. The only exception is the null 
project which is nine zeroes. If querying a range of all Projects see section below.  
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13. Click OK button after the range is entered in the Find Accounts window, the valid account 
code combination results display in the Accounts section of the Account Inquiry window.

 

14. Press the down/up arrow keys on your keyboard to move from one account code 
combination to the next or use your mouse on the vertical scroll bar (located to the right of 
the Accounts section) to move from one account code combination to the next. 

 

Enter Data Using the List of Values (LOV) 

Each segment field within the account code combination has an LOV available for use.  The data can 
be entered into each segment if known, or use the LOV to pick from the available options. 

1. Click in the each segment field. 

2. Click the LOV   button in a field. The segment name window is displayed. 

 
 

3. Click in the Find field. 
4. Enter a partial description plus the wildcard (%). The results are displayed. For example; 

o Enter 200% to find a list of organizations that begin with 200 
o Enter %VP Finance% that would list any organizations in the Description field including 

this text.  
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5. Scroll through the list to click on the appropriate option.  
6. Click OK. The selected option is now displayed in the account code segment field. 
7. Continue using the LOV for each account code segment or enter manually.  

 

8. After the range is entered in the Find Accounts window, click OK. The valid account code 
combination results display in the Accounts section of the Account Inquiry window. 

 

9. Press the down/up arrow keys on your keyboard to move from one account code 
combination to the next or use your mouse on the vertical scroll bar (located to the right of 
the Accounts section) to move from one account code combination to the next. 
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Query One Account Code Combination 

To query a single account, the same values need to appear in both the Low and High segment fields.  
The system automatically moves you to the High field in each segment and transfers the same entry. 
You will leave this default in all the High fields if you are querying one account code combination. Or 
if you want to query one account code combination but with all natural accounts, only enter a range 
in the natural account field. See natural account information below. 

 

Query Account Code Ranges 

To query a complete range in a specific account code segment you can either; 

1. Enter 0’s in the Low fields and 9’s in the High fields, unless it is for the Project segment then 
enter 0’s in the Low fields and z’s in the High fields, or  

 

EXAMPLE:  

If you want all natural account codes in the account code: 010-0000-20010-XXXXXX-UN200600, 
enter all zeroes in the low field and all nines in the high field in the Natural Account segment. 

 
2. Leave the account code segment Low/High fields blank. It will query all available values in 

that particular account code segment.  

ATTN: IT IS NOT RECOMMENDED TO LEAVE MORE THAN ONE ACCOUNT SEGMENT BLANK.  

THE QUERY MAY CAUSE THE SYSTEM TO SLOW DOWN CONSIDERABLY.  

 

3. Click OK button. After the range is entered in the Find Accounts window, the valid account 
code combination results display in the Accounts section of the Account Inquiry window. 
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4. Press the down/up arrow keys on your keyboard to move from one account code 
combination to the next or use your mouse on the vertical scroll bar (located to the right of 
the Accounts section) to move from one account code combination to the next. 

 

Query a Single Account with All Natural Account Code Transactions 

If you want to query one account code combination but with all natural account code transactions, 
only enter a range in the natural account field.  

1.  Enter 000000 in the Natural Account / Low field. 

2.  Enter 999999 in the Natural Account / High field.  

 

Example: The values entered in the Find Accounts window above, will produce results for one 
account code combination: 010-0000-20010-UN2006000 with all relevant Natural Account codes. 

 

3. Click OK. After the range is entered in the Find Accounts window, the valid account code 
combination results are displayed in the Accounts section of the Account Inquiry window. 

 

Query a Range of Project Accounts 

To query for a range of Project account code combinations enter a unique combination into both 
the Low and High segment fields. The project segment is the only alphanumeric segment field.   

1. If querying a range of Projects, enter the value in the Project / Low field (Alphanumeric 
Format: XX#######). The first two characters must be capitalized. The only exception is the 
null project which is nine zeroes. 
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2. If querying a range of Projects, enter the value in the Projects/High field (Alphanumeric 
Format: XX#######). The first two characters must be capitalized. The only exception is the 
null project which is nine zeroes. 

3. Click OK. After the range is entered in the Find Accounts window, the valid account code 
combination results are displayed in the Accounts section of the Account Inquiry window. 

 

ATTN: TO QUERY FOR ALL PROJECTS IN A SPECIFIC SUBSET OF FUND TYPE/FUND/ORGANIZATION COMBINATIONS, 
ENTER NINE 0’S IN THE LOW FIELD AND NINE Z’S IN THE HIGH FIELDS. 

 

NOTE: In the example below, the query will display all Projects in the specific subset of Fund Type 
010, Fund 0000, all Organizations, and all Projects, but only Natural Accounts from 400000-499999. 

 

Querying a New Range of Account Codes 

You can modify the original account code range or clear your results to query a new range of 
accounts; 

1. Click in the first line of the Accounts section. 

 

2. Click the Find icon in the toolbar. The Find Accounts window displays. 

 

3. Click the Clear button to make modifications to the selection criteria or to start a new query. 

4. Enter values in Low/High account code segments. Refer to the Enter Data Manually or Use 
List of Values (LOV) section above. 

5. Click OK button.  
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BUDGET NAMES 

1. Click in the Budget field.  

2. Click the List of Values (LOV)  button. The Budgets window is displayed. 

3. Click on the OU FMS BUDGET option. This is the default budget option.  

o OU FMS BUDGET-Ohio University Financial Management System Budget 

4. Click OK button. Results are displayed in the Budget section. 

 

 

SUPPLIERS/TRADING PARTNER 

Supplier Name or Trading Partner is used throughout Oracle eBiz. You may either enter or search for 
the Supplier name or Trading Partner name.  

1. Either click in the Supplier field and enter the name or partial name of the supplier plus the 

wildcard, or click the List of Values (LOV)  button and enter name of Supplier.  It is 
recommended to enter a partial description plus the wildcard (%). The wildcard should be 
used in the beginning and end of the description entered. Supplier names may be entered 
differently in the Supplier tables than the familiar DBA or “Doing Business As” name.  
 

2. Click Find button.  
o If you searched from the Supplier field and there is an exact match, the supplier name 

will be automatically entered in the Name field.  
o If you searched from the Supplier field and there is not an exact match, the Supplier 

window is displayed with a listing of supplier names that include “gray”. Scroll down the 
list and click the appropriate supplier name. Then, click OK button.  

o If you searched from the LOV, the Suppliers window is displayed with a listing of supplier 
names that include “gray”.  Scroll down the list and click the appropriate supplier name. 
Then, click OK button.  
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NOTE: In the above example the end user was looking for Graystone Advertising. The actual supplier 
name was entered as GBSA INC DBA GRAYSTONE GROUP ADVERTISING. The supplier name would 
not have displayed in the result set if the end user had entered “gray%”.  Since there was part of the 
supplier name before “GRAY,” the wildcard (%) must also be entered before the name description as 
well as after the name description. 

 

Entering search criteria- Supplier/Trading Partner (error message) 

If you enter a supplier name that is not in the system or is a non-supplier you will get one of two 
errors. A message at the bottom of the window and/or a popup window.  

 

Error #1-Message displays at the bottom of the Supplier/Trading Partner window. 

 

Error #2-An error popup window displays the error message. 
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PROJECTS 

Project Number is labeled as either “Project” or “Number” on the various screens in Oracle eBiz. 
  

ATTN: SEE THE LIST OF PROJECT PREFIXES BELOW. 
 

At Ohio, Project Numbers use a prefix which identifies the type of Project. 
 

Project Prefix Table 

Prefix Type of Account  Prefix Type of Account 

GR Grants  GM Grants - Monthly Billing 

GL Grants - Letter of Credit  GQ Grants - Quarterly Billing 

GE Grants - End of Period Billing  GA Grants- Annual Billing 

GC Research Challenge  GF Grants-Foreign Sponsor 

UM Capital Improvement  UE University Endowments 

PR Renewal & Replacement - 
Contract Project 

 PH Plant Fund – Indirect Project – 
Not a Construction 

PL Plant Fund - Capital Project  PC Plant Fund   Contract Project - 
Not a Construction 

 

Entering Project search criteria- Project Number 

1. Project/Number: Enter the project number (key value or use the LOV). 

 Enter the project number: i.e., GL0010319, or partial project number plus the wildcard 
and click Find, or 

 Click in the Project/Number field and click the LOV icon. The Project/Project Numbers 
window is displayed. Enter the partial project number plus the wildcard (%) before and 
after the partial project number. Click Find button. Click on the desired project number. 
Click OK. Click Find. 

2. Task: Once the Project number is entered, to search for the task number associated with the 
project; 

 Click in the Task field. 

 Click LOV icon. Task window is displayed. Only Tasks associated with the Project will 
display.  

 Click the desired task number.  

 Click OK. 
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Entering Project Search Criteria- Customer 

The Customer in Oracle Projects module is the name of the granting agency. 

1. Either click in the Name field and enter the name or partial name of the customer plus the 

wildcard, or click the List of Values (LOV)  button and enter name of Customer.  It is 
recommended to enter a partial description plus the wildcard (%). The wildcard should be 
used in the beginning and end of the description entered. Official customer names may be 
entered slightly different in the Customers tables than the familiar name.  
 

 
2. Click Find.  

o If you searched from the Name field and there is an exact match, the customer name 
will be automatically entered in the Name field.  

o If you searched from the Name field and there is not an exact match, the Customers 
window is displayed with a listing of customer names that include “gold”. Scroll down 
the list and click the appropriate customer name. Then, click OK.  

o If you searched from the LOV, the Customers window is displayed with a listing of 
customer names that include “gold”.  Scroll down the list and click the appropriate 
customer name. Then, click OK button.  

 

NOTE: In the above example the end user was looking for Gold Foundation. The actual customer 
name was entered as ARNOLD P GOLD FOUNDATION. The supplier name would not have displayed 
in the result set if the end user had entered “gold%”.  Since there was part of the supplier name 
before “GOLD”, the wildcard (%) must also be entered before the name description as well as after 
the name description. 
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Entering Project search criteria- Project Status 

Project Statuses: Only Approved or Closed is used by OU.  
 

Entering Project search criteria- Project Category 

Project Type can be: 

 Agency-Agency-INDIRECT 

 AUX CAPITAL IMPROV-Capital Improvements for Auxiliaries-INDIRECT 

 CAPITAL ALL COSTS-Capital Projects – All cost categories-INDIRECT 

 CAPITAL IMPROVEMENTS-Capital Improvement Projects-INDIRECT 

 CAPITAL PROJECT-DOES NOT REQUIRE COMPLETE ASSET DEFINITION-CAPITAL 

 FEDERAL-Federal Contract-CONTRACT 

 FEDERAL IND BURDEN-Federal Indirect Projects with Burdening-INDIRECT 

 FEDERAL INDIRECT-Federal Indirect-INDIRECT 

 FEDERAL PELL-Federal Contract-Pell -CONTRACT 

 FEDL AIRPORT-Federal Airport Auxiliary-CONTRACT 

 FEDL RES&DINING-Federal Residence &  Dining-INDIRECT 

 HB EQUIPMENT-HB Equipment-Do not use 

 HB EQUIPMENT-HB Equipment-Indirect Project-Not Contract or Construction-INDIRECT 

 LOCAL-Local Contract-CONTRACT 

 LOCAL IND BURDEN-Local Indirect Projects with Burdening-INDIRECT 

 LOCAL INDIRECT-Local Indirect-INDIRECT 

 OTH GOVT INDIRECT-Other Government Indirect-INDIRECT 

 OTHER GOVERNMENT-Other Government Contract-CONTRACT 

 OU CAPITAL PROJECT-OU Capital Project-Do not use 

 OU ENDOW OTHER-OU Endowment Other-INDIRECT 

 OU ENDOWMENT-OU Endowments for Student Aid-INDIRECT 

 PLANT FUND MISC-IND-PLANT FUND MISCELLANEOUS-INDIRECT 

 PRIVATE GIFTS INDIRECT-Private Gifts, Grants and Contracts Indirect-INDIRECT 

 PRIVATE-Private Contracts-CONTRACT 

 PRIVATE GIFTS-Private Gifts, Grants and Contracts-CONTRACTS 

 PRIVATE ICA-Private Intercollegiate Athletics-INDIRECT 

 PRIVATE IND BURDEN-Private Indirect Projects with Burdening-INDIRECT 

 PRIVATE INDIRECT-Private Indirect-INDIRECT 

 RENEWAL & REPLAC-IND-Renewal & Replacement Accounts for Plant Funds-INDIRECT 

 RESEARCH CHALLENGE-Research Challenge Accounts-INDIRECT 

 STATE-State Contracts-CONTRACT 

 STATE AIRPORT-State Airport Auxiliary-CONTRACT 

 STATE APPROPRIATIONS-State Appropriations-INDIRECT 

 STATE IND BURDEN-State Indirect Projects with Burdening-INDIRECT 

 STATE INDIRECT-State Indirect-INDIRECT 
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Entering Project search criteria- Project Category 

Project Categories can be: 

 Agency-Agency 

 AUX CAPITAL IMPROV-Capital Improvements for Auxiliaries 

 CAPITAL IMPROVEMENTS-Capital Improvements 

 CAPITAL PROJECT-Capital Project 

 ENDOWMENTS-Endowments 

 FEDERAL GRANTS-Federal Grants 

 HB EQUIPMENT-HB Equipment 

 LOCAL-Local Grants and Contracts 

 OTHER GOVERNMENT-Other Government 

 PRIVATE-Private Grants and Contracts 

 PRIVATE GIFTS-Private Gifts, Grants and Contracts 

 STATE-State Grants and Contracts 

 STATE APPROPRIATION-State Appropriation 

 

ENCUMBRANCES 

Throughout Oracle eBiz, users often have the option of specifying whether or not to show 
encumbrance data on the screens. You may also specify what types of encumbrances to include. 

1. Click in the Encumbrance Type field. 

2. Enter the Encumbrance Type. 
Depending on what window is retrieving encumbrance type data there are different 
defaults.  

3. All Encumbrance Type option is the default. Accept the default or click the List of Values 

(LOV)  button. The Encumbrance Types window is displayed. 
4. Click on the appropriate Encumbrance Type as described in the next table. 

 

Encumbrance Type Option Description 

ALL Includes all encumbrance types. 

Commitment An encumbrance you record when a purchase requisition is approved. 

Invoice An encumbrance you record when an invoice is approved. 

Obligation An encumbrance you record when a purchase order is approved. 

 

5. Click OK. The encumbrance type is displayed in the Encumbrance Type section. 
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JOURNAL SEARCH 

You can search from the Find Journals window or the Journal Entry Inquiry window. You can enter 
search criteria in one of more fields to initiate your search depending on the information you have 
available to you. 

 

Enter Search Criteria on Find Journals Window 

Path: FMS View Only>General Ledger>Journal>Find Journals window 
 
If you use the Find Journals window to conduct a search, you can search from any of the available 
fields. Use the Period and Category fields, if the Batch or Journal name is unknown.  

Batch 

1. Click in the Batch field.  

 

2. Enter Batch name (either key value or use LOV). If using the LOV, the Batches window 
displays. 

3. Enter the Batch name or partial description plus the wildcard (%) in the Find field.  

4. Click the Find button. Results are displayed in the Batch Section.  
5. Click the appropriate Batch name. 

 
6. Click OK. You are returned to the Find Journals window. 

7. Either click the Find button to initiate the search query or continue to add criteria to fields 
to narrow the search. If you click the Find button the Journal Entry Inquiry window will 
display. For further details, refer to the Journal Entry Inquiry window section. 
 

NOTE: You can search from all the other fields using the same process as the Batch field above. 
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Journal 

Enter the Journal name (either key value or use LOV). 

Source 

Enter the Source (either key value or use LOV). 

Category 

Enter the Category (either key value or use LOV). Some examples of Category names are 
Adjustment, Internal Billing, Purchases, Payroll, etc.). 

Period 

Enter the Period (either key value or use LOV). 

Enter Search Criteria on Journal Entry Inquiry Window 

Path: FMS View Only>General Ledger>Journal>Find Journals window 
1. Close the Find Journals window. The Journal Entry Inquiry window is open.  
2. Press the F11 key. The fields become searchable and turn a light green color (color may vary 

depending on your computer display settings). 

 
3. Enter your search criteria into any field. You may enter criteria in more than one field. 
4. Press Ctrl key plus F11 key at the same time to initiate the search. 
5. Press F4 key to cancel the search. 
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ZOOM TO IMAGED DOCUMENTS FROM ORACLE WINDOWS 

The university uses the OnBase system to store imaged documents. If an imaged document is 

available for an item/row, the Zoom   icon will be illuminated. 

 

NOTE: The only purchase orders that are imaged are manually entered purchase orders that are 
printed and mailed to the supplier.  

1. Click on the row of the document (if more than one). 

2. Click the zoom icon   in the menu toolbar. The document opens.  

 

3. If there are multiple documents linked, they will be listed under Document Name. 

 
4. Click a document to open it (sample document below).  
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View or Print Any Imaged Document 

1. With the document image displayed in the OnBase popup window, view or print the document. 

 
o To view: 

 Click on the left and right arrows to page through documents over one page, 

starting with First Page, Previous Page, Next Page, and Last Page . 
 

 Zoom in on the image .  

 Zoom out on the image . 

 Click on Actual Size  icon.  

 Click on Fit Width  icon. 

 Click on Fit In Window  icon. 

 Click on Rotate Counterclockwise  icon. 

 Click on Rotate Clockwise  icon. 
 

o To print: 

 Click on the Print  icon. The Print Options window displays. 

 Click on the appropriate radio buttons for All Pages, Current Pages, or Pages. 

 Click Print button. The Print widow displays.  

 Click Print button again. 
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VIEW / EXPAND FIELD DESCRIPTIONS 

In order to view information in a field that is not fully displayed you can either expand the field to 
read the field information or click the Edit Field icon to read the field information. 

1. Display the Editor window for the current field to view more information. 
o Click in the field that you want to expand.  

 
o Click the Edit Field icon in the toolbar. The Editor window displays the full description.  

 

o Click OK or click Cancel to close the window.  

 

2. Expand the field to read. 
o Left-click the line on the right-side of the column header of the field to expand it and 

read the information in the field. A double-headed arrow should appear.  

 
o While holding down the mouse, pull the column to the right far enough to read the field 

description (see full field descriptions next). 
 
NOTE: As soon as you release the mouse, the main grid will return to the original view with the 
first column displayed. If you were moving a column to the right of the original view, you will 
need to scroll to the right to view it again. You will see the full description displayed. 
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EXPORTING SCREEN DATA FROM AN ORACLE FORMS 
WINDOW 

When your query results are displayed in the window, you may want to export the queried results.  

1. Click on the Toolbar menu File>Export. A Progress popup window displays. If there are more 
than 100 records, a Decision popup window displays asking you to Continue, Stop, or 
Continue to End.  

2. Once all the records have been selected, a Decision popup window displays. Click Yes. 

 
3. A Progress window displays a status bar as Oracle exports the data. A popup window 

displays at the bottom of the screen.  
 

 
4. Click the down arrow on the Save button then click Save As button. The file is a .tsv file. 
5. Save to a file location. 
6. Open Excel. 
7. Click File>Open, find the location of the file  

BE SURE TO CHANGE FILE EXTENSIONS TO “ALL FILES (*.*)” 

8. Click File name 
9. Click Open. The Text Import Wizard displays. 
10. Click the Delimited radio button. Leave everything else the same. Then click Next. 
11. Click the Tab checkbox, and then click Finish.  
12. Excel displays the queried and exported results. Format the Excel worksheet as desired. 
13. Save the spreadsheet. 
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WEB BASED ORACLE EBIZ WINDOWS 

Enter Search Criteria- Account From/To Field 

Follow these steps to enter search account code combinations in both the Account From field and 
the Account To field. This feature is available on the General Ledger>Account Analysis and Drilldown 
window. 

WARNING: THE SEARCH CRITERIA IS CASE SENSITIVE. THE ACTUAL ACCOUNT CODE 
COMBINATIONS MUST BE VALID COMBINATIONS. GENERIC RANGE VALUES CANNOT 

BE USED IN THESE FIELDS, E.G., YOU CANNOT USE THE RANGE 000000 THROUGH 
999999 IN THE NATURAL ACCOUNT CODE FIELD.  

1. Click in the Account From field. 

2. Enter Account Code combination: 

o Manually enter the account code combination in the following format; Fund Type-
Fund-Organization-Natural Account-Project (xxx-xxxx-xxxxx-xxxxxx-UNxxxxxxx), or 

 

o Click the search icon  to display Search and Select: Account From window. 

 

o Enter the value in each field, or 

o Click the Search icon  to display the Search and Select window. 

 Enter a partial value then click the Go button. If you don’t know a partial value, 
you can click the Go button and it will display the entire set of values for that 
particular account code segment. 

In the example below, the user entered a “3” in the search field. The resulting query 
results display every Natural Account code that begins with a “3”. 
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 Click on the Quick Select link displayed on the row of the appropriate value. 
The value will be displayed in the account code field. 

 Continue to enter values or use the search feature until all the account code 
segments are complete. 

o Click Search to initiate the search for the account code combination. The query results 
will display in the Results section of the window. 

 

o Click the radio button to the left of the account code combination. 

o Click Select. 



Document ID: FMSPA0040 Oracle Navigation 

Effective Date: 08/07/2014  

 

  Page 49 

  Finance 

 

o The Account From field is completed with the account code combination. 

 

3. Follow these same steps to enter search criteria in the Account To field. 

 
 

 

REMINDER: The search criteria is case sensitive. The Account Analysis and 
Drilldown is a web based feature. The actual account code combinations must 
be valid combinations. Generic range values cannot be used in these fields, e.g., 
you cannot use the range 000000 through 999999 in the natural account code 
field. 
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Enter Search Criteria- Balance Type 

Choose the appropriate Balance Type: Actual, Budget, Encumbrance. 

 

Actual Balance Type 

Click the dropdown arrow in the Balance Type field and click Actual to query for balances and 
journal details of actual transactions. Actual is the default option. 

 

Budget Balance Type 

Query for balances and journal details of budget transactions. 

1. Click the dropdown arrow in the Balance Type field and click Budget. A Budget field is 
displayed. 

2. Enter the Budget description, which is OU FMS BUDGET, or  

3. Click the Search icon  to display the Search and Select: Budget window.   
4. Click the Go button to display the Budget descriptions.  

5. Click on the Quick Select link displayed on the row of OU FMS BUDGET. The value will 
be displayed in the Budget field. OU does not use the FND FMS BUDGET.  

 

OU FMS BUDGET-Ohio University Financial Management System Budget The value will be 
displayed in the Budget field.  
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Encumbrance Balance Type 

Query for balances and journal details of encumbrance transactions. 

1. Click the dropdown arrow in the Balance Type field and click Encumbrance. An 
Encumbrance field is displayed. 

2. Enter the Encumbrance description, or  

3. Click the Search icon  to display the Search and Select: Encumbrance Type window.   
4. Click the Go button to display the Encumbrance Type descriptions.  

5. Click on the Quick Select link displayed on the row of the appropriate value. The value 
will be displayed in the Encumbrance Type field. 
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Enter Search Criteria- Period From /To 

Follow these steps to enter search criteria in both the Period From and Period To field. Both fields 
will display the default of the current accounting period. To change the Accounting From/To fields; 

 

1. Click in the Period From field. 
2. Enter the Period description, (month, calendar year, fiscal year, e.g., JUL 2013-14), or  

3. Click the Search icon  to display the Search and Select: Period From window.  

4. Enter a partial value then click the Go button. If you don’t know a partial value, you can click 
the Go button and it will display the entire set of values. 

 

5. Click on the Quick Select link displayed on the row of the desired accounting period. 
The value will be displayed in the Period From /To field.  

6. Follow these same steps to enter search criteria in the Period To field. 
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Sort Search Results- in Web Based Oracle Windows 

Once you have search results displayed in the web based Oracle window, you can sort the data, if 
the sort feature is available in the column header.  

 

1. Click in the column header. If an arrow appears in the column header you can sort that data. 
2. Sort the data to view it by Period and back again to sort by Account code, if desired. 

o Click in the title bar of the results, in the particular column by which you want to sort. 
The data is sorted in ascending order. An up arrow appears. 

o Click in the column to reverse the order of the data to appear in descending order. A 
down arrow appears. 

 

o Click in the Account column to sort by account code combinations, either in ascending 
or descending order. 

 
3. To view all the query results, click the Next 10 link in the bottom right corner of window. 

Click the Previous link to go back to previously viewed results, or click the down arrow and 
return to previously viewed results. 
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Defining Personalize Views in Web Based Oracle Windows 

Create View (Search) 

Refer to individual training documents to access how to search from specific Oracle web based 
windows; General Ledger-Account Analysis and Drilldown, General Ledger-Account Inquiry, General 
Ledger-Journal Entry Inquiry, etc.  

 

Save the Created or Updated View 

After customizing the view of the results table, you can; 

 

1. Click Apply and View Results (see button highlighted in red in above screen shot) to save 
and immediately view the results of the updated view (search).  
Depending on what window you were on either the View Journal Entry Lines>Views window 
or the Account Balances>Views window is displayed with the updated results. View results. 
For more detailed instructions to view results refer to the Access a Saved View (Search) 
section. 

2. Click Apply (see button highlighted in red in above screen shot) to save the updated view 
(search). The Personalize Views window is displayed. The saved views are listed. 

3. Click Revert (see button highlighted in red in above screen shot) to revert back to the 
existing view. This can be used if you have started to edit search parameters in the existing 
view and you want to start over but with all the original search parameters without 
canceling and selecting the view again.  

4. Click Cancel to cancel saving the new view. 
 

Access a Saved View (Search)  

To access the saved views depends on your current location in the system.  

1. You can access the saved Views from Account Analysis and Drilldown window, Account 
Inquiry window, or from Journal Inquiry window.  
o Account Analysis and Drilldown to Saved Views: 

 To access saved views that were previously created follow the path: Click General 
Ledger > Click Account Analysis and Drilldown.  The Account Balances window is 
displayed. Go to step #4. 
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 To access a saved view directly after creating the view and applying (saving) the 
query, click on Saved Views button. Go to next step #4. 

o Journal Inquiry to Saved Views: 

 To access from login; Click General Ledger > Click Journal.  Enter your search 
criteria, then drilldown to the View Journal Entry Lines. 

 Click on Views button. Go to step #4.  
o Account Inquiry to Saved Views: 

 To access from login; Click General Ledger > Click Account.  Enter your search 
criteria, then drilldown to the View Journal Entry Lines. 

 Click on Views button. Go to step #4.  
2. Click the dropdown arrow in the View field.  

 
3. Click on the appropriate view (saved search).  

 
4. Click Go. Oracle will display the results of the original search criteria for that saved view. 

View existing results. 
5. Click the Next ## link or the dropdown arrow   to view additional pages of the search results.  

 
 

6. To drilldown, click the PTD dollar amount. For more detailed instructions, refer to the 
General Ledger-Account Inquiry document. 
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Personalize / Edit a Saved View (Search)  

Access saved views that were previously created in order to update an existing view, duplicate a 
view (then rename it and edit it), or delete a view. You can also create a new view from the 
Personalize Views window by selecting the Create View button.  

1. You can access the Personalize Views window from Account Analysis and Drilldown or from 
Journal Inquiry. You can get to the Views window several ways depending on your current 
location in the system. 
 
Account Analysis and Drilldown to Personalize Views window 

o To access from login; click General Ledger > Click Account Analysis and Drilldown.  The 
Account Balances window is displayed. 

o Click on Saved Views button or New Search button then Saved Views button depending 
on your location in the system. 

     Journal Inquiry to Personalize Views window. 

o To access from login; Click General Ledger > Click Journal.  Enter your search criteria, 
then drilldown to the View Journal Entry Lines. 

o Click on Views button. 

2. Click the Personalize button.  
 

ATTN: FROM THE PERSONALIZE VIEWS WINDOW THE FOLLOWING OPTIONS ARE AVAILABLE; DUPLICATE A SAVED VIEW, 
CREATE A NEW VIEW, UPDATE A SAVED VIEW, OR DELETE A SAVED VIEW. 
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Update a Saved View (Search) from the Personalize Views Window 

 

1. Click Update to update an existing view. The Update View: Name of View window is displayed. 
The view (search) originally created is displayed. 

 

 
2. Edit applicable search criteria fields. For more detailed instructions refer to Create View section 

above. 
3. Save the search. For more detailed instructions refer to the Save the Created or Updated View 

section in this document. 
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Delete a Saved View (Search) from the Personalize Views Window 

 

1. Click the Delete icon in the row of the saved view you wish to delete.  
 
NOTE: A warning window is displayed with a question; Are you sure you want to delete your 
table personalization view: [Search Name]? 

 
2. Click Yes to delete the view. You are returned to the Personalize Views window. 
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Duplicate a Saved View (Search) from the Personalize Views Window 

A view can be copied or duplicated and then edited and saved. This will save time from creating a 
new view if only a few search parameters need to be edited.  

 

1. Click the Select radio button to the left of the view you want to duplicate. 
2. Click Duplicate. The Duplicate View window is displayed. The page defaults to the display 

settings and query options of the saved existing view.  
3. The View Name field will display the original description of the saved view with the words 

“Duplicate of” in front of it. Enter the View Name to match the applicable new search 
parameters. 

4. Edit the applicable search parameters. Refer to the Create View (Search) section in this 
document for detailed instructions. 

 

 
5. Save the search. For more detailed instructions refer to the Save the Created or Updated 

View section in this document. 
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Create a New View (Search) from the Personalize Views Window 

A new view can be created from the Personalize Views window. The process to create a view is the 
same as creating a view from any accessible window that displays the Create View button. The page 
defaults to the pre-seeded display settings, where no query options are set. 

 
1. Click Create View. The Create View window is displayed.  
2. Enter the view name, set search parameters, and save the view.  Refer to the Create View 

(Search) section in this document for detailed instructions. 
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Exporting Screen Data from an Oracle Web Based Window 

The Export button is located on several windows in the OUFMS: View Only>Accounts Responsibility 
in the Oracle web based windows. Query the records you want to export. To Export the data: 

1. Click Export button . A popup window displays at the bottom of your screen. 

 

2. Click down arrow on the Save button then click Save As button. The file is a .txt file. 

3. Save to a file location. 

4. Open Excel. 

5. Click File>Open, find the location of the file. 

BE SURE TO CHANGE FILE EXTENSIONS TO “ALL FILES (*.*)” 

6. Click File name 

7. Click Open. The Text Import Wizard displays. 

8. Click the Delimited radio button. Leave everything else the same. Click the Next button. 

9. Click the Tab checkbox, and then click Next. 

10. Click the General radio button and click Finish.  

11. Excel displays the queried and exported results. Format the Excel worksheet as desired. 

12. Save the spreadsheet. 

 

 


